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System Requirements

e Microsoft Windows 2000, XP, Server 2003 or Vista (32 or 64bit).

e 20 Mb of free Hard Disk Space.

e Adobe Acrobat Reader to access the CD version of the tutorial.

e We recommend that all the latest critical updates are installed

from: http://windowsupdates.microsoft.com

Note: The mimics in the Flowol 3 package will also be installed. The ‘Big Wheel” and ‘Cot Mobile’ are
new F3D mimics which have 3D animations. The speed of the animation will depend on the graphics
capability of your computer. One way to speed up slow animation, at the expense of image quality, is to
remove the check mark from the ‘Use anti-aliasing’ option in the Mimic tab of the Options dialog from
the Settings menu.

Installing Flowol

e Insert the Flowol 3.10 CD ROM into the CD Drive.

e This is an auto play CD ROM, which means that Windows should detect the presence of the
CD and automatically start up the Auto run program.

e Follow the on-screen instructions to complete the installation of the Flowol and its
associated files onto the hard disc.

e When installation is complete, eject the CD ROM and store safely.

Note: If the Auto run program fails to start, use Windows Explorer to navigate the CD ROM contents and

double click on the file Setup.exe.

[See p.33-37 for installation onto Windows and RM networks]

Important Notes:

1. When using the Mimic Creator after installing Flowol3, you will need to use the ‘Set Mimic
Directory..” in the Mimic Creator’s file menu each time you need to access the 2D mimics.
Or transfer the mimics as explained above if you need to access them by default.

USB Users: Ensure that the interface is NOT connected when the Flowol software is installed. If you
have installed the FlowGo/Solo drivers with a previous version of Flowol, uninstall them first by going to
the Add or Remove programs control panel and remove the ‘FlowGo/Solo USB Drivers (Flowol 2.91)’
program.
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Getting Started

To start the Flowol software once it has been installed:
1. Click on the Start button on the taskbar.
2. Within Programs, select Flowol 3 and click on the Flowol 3 icon.

\ 4

Configuring Flowol

Flowol can operate with or without an interface attached. If the ‘No Interface’ option is selected,
Flowol will automatically be in simulation mode with the maximum number of inputs and
outputs available. If an Interface has been selected from the list then Flowol can operate either:

« Without the interface connected, = open (in simulation mode), so that the correct
number of outputs, inputs and commands are available for that interface.

« Or: with the interface connected, = Closed (interface in operation).

The following interfaces are supported:

Data Harvest: Contact Controller Plus
Contact Controller
FlowGo [Serial/lUSB]
Solo

Fischertechnik: Robo [Serial/USB]
Intelligent Interface [Serial]

Deltronics:  Serial Interface
Serial Interface +
Junior Interface
Extra Sense [Serial Interface] to operate the Control IT Buffer Box.
Digital Serial Adapter: to operate the Control IT Buffer Box.
Control and Data Capture Interface [USB]

Economatics: Smart Box
Control Station

Commotion: Serial Interface
Junior Interface
Commotion CoCo [USB]

LEGO DACTA: (Control Lab) Interface B
PICAXE
FlowIC

Other interfaces may be added in the future and available for download from the website.
http://www.flowol.com/flowol3/interfaces.aspx
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Setting up Flowol for your Interface:

e Open the Settings menu and select ‘Interfaces’ to open the ‘Choose Interface’ window.

ﬂUntitled - Flowol 3 - Copyright Keep L.T. Easy
File | Settings Edit Mimic Graph  iew Help

|y Pausethe Flnchart
——  Single Step
Fun What? » | Awailable interfaces:
x r~ Interface options
BN [nterfaces... T N— S—
Cptions. . E-'!:eltrl_lr|ll:~ Control and Datacapture Box Connection: USE only
18 Cornrnokion Coco
| Salo 18
Solo 28
FlowIC

Conkact Controller

Contack Controller Plus
Deltronics/Cormmotion Junior Serial
Deltronics/Cormmotion Serial
Deltronics Serial Interface Plus
Deltronics Digital Serial Adapter
Economatics Control Station
Economatics Smart Box

LEGOD DACTA Contral Lab
Fischertechnik, Inteligent Serial

Mo Interface

Save settings and Ok | Ok I Cancel |

e Select your interface from the list shown and wait a few moments until its picture is
displayed.

o If your interface is USB connection only, there will be no further options.

o Ifthere is a dropdown menu you will need to select the appropriate
communication port. E.g. an available COM port for Serial connection, or the
USB.

o Select the labeling (0 — 7) if required. [Note: the Tutorial is written for the 1 — 8
setting].

o Ifyou are using the Digital Serial Adapter or Extra Sense, the interface connected
to it might need to have the ‘High’ selected.

e C(Click ‘Save settings and OK’ if you would like this selection to be automatically
configured when Flowol is next used. Click ‘OK’ for these settings to be used for this
session only.

e The program should now detect the interface if it is connected to the computer. The

[connecting plug icon] will flash and close [interface in operation]. To work in
simulation mode, click on the icon to open the connection.

Note: Some interfaces have restrictions on the number of inputs, outputs and motors available,
which will not always match the labels on the mimics. When the ‘No Interface’ option is
selected, Flowol will have the maximum number of inputs and outputs available but will only
work in simulation mode. These can be changed with the ‘Advanced’ option.

Mimic Options: Some 3D mimics can be re-labeled to suit the user’s interface.

E.g. after configuring for the interface, open the ‘Mobile’ ——

mimic and select ‘Mimic Options’ from the Mimic menu. imic Labels T
The user now has the options of changing the ‘Val’ label and M) === e

the use of Motor B. These changes will be saved by Flowol 't the ropalbr ad okt o B

in the .flo file with the flowchart. o ] oo |
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The Tutorial

Introduction

This tutorial introduces Flowol software and the flowchart method of creating a control program.
It is a hands-on approach which puts the reader through a series of problem solving exercises.
Each exercise uses a control program to explore different elements of control, starting with
simple ideas and progressing to more complex examples. The features of Flowol are introduced
gradually at each stage.

Using the Tutorial
[The tutorial, also on the Flowol CD, will be installed automatically so it can be accessed from
the ‘Help’ menul].

Pages 7 to 20 are an appropriate introduction for all students. Since the examples are

progressive, you can decide how far your students should go. Each theme in the tutorial gives
direction to possible solutions, and several of the pages can also be used as worksheets. Ideas
should be transferred from one section to another and extended to provide a complete solution.

It might also be useful to refer to the Student’s Activities available on the web site. These
activities are a pupil based text to support parts of the Flowol tutorial and also the extra Primary
and Secondary Mimic Discs. The controllable tasks are progressive, similar to those in the
tutorial, but focus more on the problem solving aspects of the examples rather than acquiring the
skills to use the software.

Extra mimic packs are available, check http://www.flowol.com for details.

Why Flowol?

Flowol is normally set to operate in simulation mode. This allows all students on a computer to
actively create, test and refine their control solutions. The mimics are controllable pictures
which respond in a realistic way and the visual activity of the flowchart allows the logic to be
easily followed and amended.

When models are connected and operated through a control interface, the mimics still respond.
Readings from analogue sensors can also be logged and used to control events. The computer
screen then also becomes an important monitoring tool. Industrial processes, security systems
etc. are often monitored in a similar way.

Copyright: all rights reserved. This tutorial may be copied for use within the premises of the
licensee on the condition that it is not loaned or sold.

Keep I.T. Easy acknowledge that there may be error or omission in this publication for which
responsibility cannot be assumed. No liability will be accepted for loss or damage resulting from
the use of information contained in this tutorial or from uses as described.
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Flowol Control and Data Logging

-
o
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5 TAutohome flo* - Flowol 3 - Copyright Keep L.T. Easy
ile Settings Edit Graph Wiew Help
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The Workspace
The Flowol workspace is the area of screen
available to build the flowchart program.
This initially has a size of 4 pages, capable
of holding 220 symbols, but these
dimensions can be changed.

Temgp.

SENzOr

The Toolbar
i) Click on a Tool/symbol to select it.
i) Click again on the workspace to
position it.
iii) A prompt box will appear at the
bottom of the window. It contains
all the items that can be entered into =

4
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allow the programs to be developed and
tested in ‘Simulate’ mode.
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logged as a separate application. o
ii) Inputs and outputs can be plotted { -
together to show the response of the
controlled outputs. .
» 1} < rnin
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Erase/Delete

The Erase Tool will highlight and become active when part of the
X flowchart has been selected for editing.

\ 4

Start/Stop/Sub  Use the Start symbol at the beginning of the flowchart program.

:) Use the Stop symbol at the end of a subroutine, and at the end of a program
which is not recursive (repeating).

Use the Sub symbol to head a subroutine. (Note: subroutines should be
defined before the main program).
Use the prompts to make your selection.

Output
Use the Output symbol to turn on or turn off an output or a motor.
Use the prompts to make the selection. (Note: all the outputs or all the
motors can be turned on or off within one symbol).

Process .
Use the process symbol to put in a delay. (e.g. how long the output needs to
be switched on for).
This is also used to call up a subroutine, or to set up a variable. Use the

prompts to make your selection.

Decision Use the Decision symbol to decide if “Yes do this’ or ‘No do that’.

For example, it can be used to check for feedback from an input signal such
as: is the switch on; or is the temperature value more than, less than or
equal to x? This symbol can also be used to check the values of a variable.

Use the prompts to make your selection.

Text Click on the Text Tool to add a title, or comments on the flowchart. Click
on the workspace to position the text window. Type in the text window that
| appears on the workspace. Edit the text with the font toolbar at the top of
the screen
Edit

e Click on the Edit Tool (or use right mouse button) when you need to
highlight symbols, lines, labels or section of flowchart. They can then be
erased, changed or moved.

—

Use the Line Tool to link the symbols together to create the flowchart.
Where a decision symbol has been used, then both a YES and a NO line
have to be used. [The Yes/No selection box appears when you first click on
the decision symbol]. e.g. If switch is pressed (Yes) - do something.

If switch is not pressed (No) - go back and check again.

- B ‘ Start / Stop button to run or stop the program.

Interface connection. E.g. if configured for an interface you can switch
= - between simulation mode and interface operation mode.

Note: a ‘Remote’ tool will become available when configured for FlowGo,

Solo or PICAXE
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Mimic An All-Stop road intersection
‘All Stop’
Resource SKill: To connect three of the basic flowchart ‘Tools’ to create a

6V bulb connected to Output 1 | control program to turn output 1 on for 5 seconds, then turn it off.

Program:
1 Select the Start symbol ‘“Tool’ and click again on the workspace to position
and fix the gray image of the symbol. Use the prompts to select Start. ( Start )
1t H '|Turn Qutput 1 on ok Cancel
2  Select an Output symbol — position it Al t : Lo ] om |

under the Start symbol. Use the prompt e |
to Select: Turn Output 1 on, —
click on OK.

Speak

Turn
Output 1 on
3 Select a Process symbol — position =~ W [beieys o] o |

. Delay | |75 sssss ds Delay 5
it under the Output symbol. Use the s | 70s]s]c

prompts to select Delay 5 Click OK. CIED -

BEAE

4 Select the Output symbol — position it under the symbol above. Use the f outout 1 off /
prompts to select Turn Output 1 off. Click OK.

5 Select a Stop symbol — position it under the symbol above. Use the prompts @
to select Stop. s

6 Select the Line tool to link the symbols
i) Click on the ‘Start” symbol (it will highlight green).
i) Click on the symbol beneath it. (The line will be drawn).
iii) Click on the second symbol again. (This is the start of the next line)
iv) Click on the third symbol etc and continue until the flowchart is

complete.
To run this short program, click on the ‘ symbol in the toolbar. To stop the program click
on the symbol again [note: in this example it may stop automatlcally at the end of the

sequence].

- 3@ K

Bridge Lights  Light House: Mobile Big Wheel

To open up the mimic: click on the mimic
icon on the Toolbar. Choose ‘All Stop’. To
show the labels, click on the label icon.

Note: If you already have Flowol 2 mimics in
another folder, select ‘Flowol 2 mimic folder’
in the Mimic window. Browse and select your
old Flowol 2 mimic folder.

To test the action of the mimic: click on the
light on the mimic to turn it on, click again to
turn it off. RUN your program again.

To save a program: open the File menu, then
click on Save As... give your program a
filename [e.g. ‘allstop’], OK
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Changing and Adding Instructions.

Mimic )

‘All Stop’ and ‘Crosswalk’ Skill: To modify a flowchart

ResoUrces |) Remoye ur_1wanted _sym_bols

6V bulb connected to outputs 1 & 2 !!? Changmg information n the symbols
iii) Inserting extra symbols in a sequence
iv) Have multiple outputs in a symbol
Moving the prompt box

Removing a mistake:

Symbols or lines in the wrong place can be removed.
Select the edit tool (Hand). Note: the right mouse button is an edit Short-cut, instead of
clicking on ‘Hand’
[”]] Click on the incorrect line or symbol to highlight it, and then click on ‘% at the top of
the toolbar. ( Start ) ( Start ) ( Start )

Changing Information e.g. delay time

1 Select the edit tool (Hand) - - .

2 Click on the ‘Delay’ in the Output 1 on Output 1 on Output 1 on
flowchart, to highlight it.

3 Click on ‘C’ on the prompt box
number pad and change it to 2. OK. Delay 2 Delay 2 Delay 2

Change delay

Inserting Additional Symbol:

1 Select another process [delay] / Turn / / Turn / / Tum /
Output 1 off Output 1 off Output 1 off
symbol from the toolbar.
2 Place the orange image on the line Insert extra process

above the Stop symbol. The chart oy T
will automatically re-draw itself. @ "

3 Use the prompt bOX to prOduce: Erase this stop & draw new line
Delay 2, OK (s (s )

To make the ‘All Stop’ flash forever
’

re »' -NC;SV. "_!\ - .

(recursive):

1 Select Edit tool, click on the Stop
symbol and erase it with X tool.

2 Now draw a line from the second
Delay to the process symbol at the
top which turns output 1 on.

Run and Save this new program —.

Now load the ‘Crosswalk’ mimic and
modify your ‘all stop’ routine [see Multiple
outputs below] so that the lights (outputs 1
& 2) flash alternatively.

Run and Save your program —

Multiple outputs can be triggered in the same output box by simply selecting as many as you
wish in the prompt box.
|Turn Output 2 on 1 off | OF | Cancel |

Move the prompt box if it is in the Way/|'p — o o] :I

by dragging it with its shortened title bar %‘ o T
on the left hand corner. =

(__Page1o ) »| ©KeeplT.Easy2008 | »( Flowol )

4 Output Off On
5 Qubput Qff On
& Oukput Qff On ;I




( Flowol ; :I Primary/Secondary =®

Mimic Traffic Lights

‘Intersection Lights’

Resources
Output 3 -6V bulb
Output 2 — 6V bulb
Output 1 - 6V bulb
Etc.

1 Labeling the Flowchart:

Re-write the label in the text window.

SKill: Putting Text on the flowchart
Simulations with monitor Toolbars.
Editing the information in a symbol.
Printing the flowchart.

Select the Text Tool, position and click the ‘Label” window on the flowchart.

Text edit icon

Sl 7 e

Edit the font by using the Font toolbar. [esa

GO w NP

and then click on the Text edit icon.
Simulation without a mimic.

Labels can be moved in a similar way to that of the symbols [click once on the label].
To edit the text in the label, double click on the label or click once on the label to highlight it,

Flowol has monitor toolbars which are normally at the bottom of the workspace.
They can be moved by dragging them around the screen. When in the workspace, they become
windows which can then be closed. They can be re-opened from ‘Toolbars’-View menu.

These monitor bars show the state of the inputs and outputs.

- Inputs: |T|?|?|T|?|?|T|E| J Wals: ll 0 §| 1] §| 0 i| 1] |

JDutputs:WE.FFEFE| J  otors: EFEW|

When the program is in simulation mode, the input can be clicked on to simulate the input changing.

Traffic Lights:

Let Output 1 be green, Output 2 - amber and Output 3 - red and build up the flowchart shown below.

To Edit the instructions in a symbol: re-select
the symbol on the workspace [highlight blue] to
re-open its prompt box

Note: If the symbol is already selected but the
prompt box is not open, then you need to click on
the workspace first; and then click on the symbol
again.

Click on the options in the prompt box to make the
changes. E.g.to change an On to an Off, just click
on the Off [they will toggle]. To remove the On
altogether just click on it again. Note: When
starting a new column always work downwards.

Run the program. Note: the light sequence is not
quite right. Make the correction and save your
program .

To print the flowchart, = & §| & click on
the printer icon on the top toolbar. [See details
about the full printing options on page 25].

( Start )
Traffic Lights

<

Turn
Output 3 on

i Turn Output ;
Delay 7 2 on 1 off
i Turn Output  /
2on3 oa’f 4 Delay 3
Turn
Delay 3 f Output 2 off ;
Turn Output
1 on 2 off

Delay 7

-~
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Mimic Double Set of Traffic Lights

‘Intersection Lights’

Resources Skill:

Outputs (1 to 6) — 6V bulbs i) Changing the scale of the flowchart

i) Undo and Redo
. P iv) Click on the mimic to test its function.

Testing the Outputs on the Mimics: v Slowing down the flowchart
Display ‘Intersection Lights’ mimic and show 5 Flowol Mimic

the labels c=.

If you carefully click on each of the lights on
the mimic, you will make them turn on; click
on them again to turn them off. Also observe
the output monitor bar. Now click on the
outputs on the monitor bar to see the effect on
the mimic.

Run the Traffic Lights program and check it
out on the mimic. Change/edit the delays until
you have the best result.

|Im vl|ﬂvﬁ7|

100% -

a0
/ nx T
Undo and Redo can be used to step back and then forward
again through the stages of creating the flowchart.

Re-scaling [Zoom] the flowchart. When the flowchart becomes too large to be
seen in one frame, use zoom to observe more symbols on the monitor screen. [80%

is a useful, readable size]. The Zoom default can be changed from ‘Options’ in the Deiay >
Settings menu.

Symbol Tooltips: Having < 80% is useful when re-arranging the flowchart but the
symbols are difficult to read. Tooltips will appear [if Zoom<80%] when the cursor ||
hovers over a symbol. These Tooltips can be turned off from the View menu.

Double Set of Traffic Lights

This can be done by either constructing another flowchart for the second set of lights, or by
modifying the sequence for the single set of lights. [e.g. insert extra symbols or edit some of those
symbols already there]. Run the program and observe the effect on the mimic so your program
can be checked and refined. Save your new program.

Reducing the Speed of the Flowchart or Stepping Through the Program is useful when
demonstrating or checking for errors. Open the Speed toolbar from ‘Toolbars’ in the View menu.

[View Hel Make the speed adjustment by B

.....................................................

' 2T moving the slider. The ‘speed tool’ } fnow

v Status Bar w Fonts N
v Tips When at Small Zooms v Symbols WlndOW can be Closed or dragged to
the top or bottom toolbars. € Slow-Fast—>

Yariables
Sound Recorder : ::Li;tusts —_— J_ |W =|
v Mokars : : I/
v Yals To step through the program, first pause the flowchart
by clicking on the icon [or from Settings menu] and then step

from one symbol to the next using the Spacebar or step icon.
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The Lighthouse

Mimic Skill:  To use multiple flowcharts:
Light House i) Move sections of flowchart.

i) Copy a flowchart.
Resources iii) Changing the color of the flowchart.
Output 2 - buzzer iv) Controlling a model through a control box.
Outputs 1 & 3 -6V bulbs

Open the Light House mimic, re-load the ‘allstop’ program, from the earlier example,
and run it to observe the effect on the mimic. Stop the program again.

Try moving Sections of flowchart: (individual symbols or groups of symbols)

1 Select the edit tool (hand).

2 Click on the symbol in the flowchart to be moved and it will highlight.

3 Use the left mouse button to drag the symbol and then release.

4 To highlight a group of symbols, drag a box around the group. (Click left
mouse button at one corner of the group, drag a box across them and release).

5 Select any one of the highlighted symbols to drag the group.

6 Move the group back or use Undo.

Controlling the Foghorn on the lighthouse: Main Light ey

Copy the flowchart: (E @
Select edit tool and highlight the
flowchart by dragging a box around it. Output 1 t0 2

(explained above).
Turn Turn
i) Hold the Shift key and drag one of the @“j @tzj

highlighted symbols to drag a copy of
the flowchart to one side, release mouse
button. Delay 2 Delay 1

i) OR: use the Copy and Paste 4 4

icons. See details of Cut, Copy and
Paste on page 17. i Tum / i Tum /
Output 1 off Output 2 off

The outputs in the second flowchart now need
to be re-defined as Output 2.

Delay 2 — Delay 3 —

It may also be advisable to change the delays:
Delay 1 when buzzer is ‘on’ and Delay 3 when
‘off’. Save the ‘lighthouse’ program.

Change the Delays

To change the colors of the flowchart: select ‘Colors’ from ‘Options..” in the Settings menu.
Note: stronger colors may be useful for demonstrations but strong, flashing colors can be
unpleasant for the user, or even dangerous for some users who suffer from epilepsy.

Connecting to an Interface and controlling a model:
If Flowol is configured for an interface [see p.5] and your control box is connected to the
computer, you can switch from simulation mode to interface mode by closing the plug connector

icon on the toolbar e.g. =~ to "~ or vice versa to return to simulation mode.
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Lighthouse with a switch

Mimic

Light House SKill:
Resources

Output 3 -6V bulb
Output 2 — Buzzer
Output 1 — 6V bulb
Input 1 — switch or LDR

Using an Input (Decision) symbol.

Using an input switch to control the interior light in the lighthouse:
An input is observed by a decision symbol. When the program is running the decision
instruction ‘looks’ for a fraction of a second to see if the input is On or Off.

The diagrams below show the steps needed to build the procedure for the interior light program.

Create and position these four symbols. When you click on the decision symbol to draw the first
line it will highlight the symbol [green] and open a window for you to decide if this first line is to
be a YES or NO line. Make your decision (e.g. YES) and then click on the destination symbol [Turn
Output 3 on]. When you highlight the decision symbol for the second line, the program will
already know it is for the NO line. Click on the destination symbol [Turn Output 3 off]. Add the
extra lines to complete the flowchart. Write some labels and Re-Save the program.

The inside light

Start

Is Input 1 off @
hO ES

Turm Turn Turm Turn
Output 3 on Output 2 on Output 3 on Output 3 on
Turn Turn Turn Turn
Output 3 off Output 3 off Output 3 off Output 3 off

Using a light sensor as the switch. i riowil SRR x|

A light sensor is On when it is light and Off
when it is dark.

8 G
&

Run the ‘lighthouse’ program and click on
the Moon/Sun (input 1) on the mimic. This
will simulate the effect of changing the light
sensor.

Now insert decision symbols to the other
flowcharts so that the main light and foghorn
are also controlled automatically by the
daylight.

Test your program and re-save it.
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Lighthouse with Subroutines and Sound

Skill: Using Subroutines

Subroutines
When a section of flowchart needs to be repeated, it is better to use a subroutine and a separate
main routine to command this subroutine. The subroutine however, must be defined and drawn
first, so it can be selected and included in the main routine.

[In the lighthouse example we can use a subroutine to give the flashing light a signature].

@ Building a subroutine: Select the ‘Start symbol” but click on Sub (not
Start) in the prompt box. Write the name ‘flash’ in the text window and
click OK. W ISub flash [ o | cancel |
Skark |
Tumn o
/ Output 1 on ; %I [flashl
Stop Al |

<«—— The flowchart for the subroutine can then be built up in the usual way
but it should finish with a ‘Stop’

( Start ) Building the main routine:
Draw the main routine (with a ‘Start”). After
f Out;ftml off ; selecting the process symbol, click on ‘Sub’ in the

prompt box. A list of your subroutines will appear.

Delay 1

Is Input 1 off .
g Make your selection.
I [Subflashx 2 o | concsl |
Delay 1 Delay |Flash repeat |2

Sub flash x 2 Sub 7lal9e|c

A Let 415 | B
11213]|0
( Stop ) . . .
Deay 3 To repeat this subroutine, click on the number pad
before clicking on OK. [e.g. ‘flash’ repeated twice].

—

You can now modify the main routine by adding delays and calling up the ‘flash’ subroutine
in different ways to give the flashing light a different flashing routine [e.g. a signature].

Adding a fog horn sound to your lighthouse program.

One of your flowcharts should be controlling the foghorn output 2. Insert another output symbol L/
below the one in the foghorn flowchart which turns Output 2 on.

When the prompt box opens, choose Sound and type C:\WINDOWS\Media\ringout.wav in the prompt
box window to select the ‘ringout’ sound file already on your computer. Alternatively this can also
be found by clicking on Browse... and locating the file. Click OK in the prompt box.

Note: If you use Browse, you may then have to re-locate your .flo files folder before saving.

See details ‘Using Sound on PC Flowol’ [p.16], particularly if you wish to create your own sound.

[Extension task: Use the ‘Crosswalk 2’ mimic to build a program using inputs, subroutines and

Run what?: allows you to run a subroutine or selected Settings Edit Mimic Graph View
flowcharts on their own. Pause the Flowchart || v cu
Select ‘Run what?* from the Settings menu. Choose your SinglEsten

named subroutine from the list, and RUN the program. Fun What? A
Or choose ‘Selection’; highlight the chosen Start [or Ctrl and Inkerfaces... ————
select several Starts] on your flowchart and RUN. 22HE 00

Remember to choose ‘All Starts’ again at the end of the test.
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Using Sound on PC Flowol
[For PC computer only with sound card, microphone and speakers connected]

Sound can give extra realism to the control situations for example the foghorn on the
lighthouse. In automatic systems such as crosswalks and elevators sound is also frequently
used to help the partially sighted cope more easily.

To record new sounds or listen to =10 %]
the pre-recorded sounds on your File Edt Effects Help

Sound Recorder by clicking on the

Sound Recorder icon "% [menu bar
or Sound prompt box].

computer [at C:\WINDOWS\Media\...] o p— Length of
you need to open the Windows Rp—— = 000 s 4 time of the
: : : : recording
|
I

— Record

Play Stop

Recording your own sounds:
e Attach a microphone and speaker to the sound card.
e Open the Flowol program.

e Launch Microsoft’s Sound Recorder by clicking on the "% icon [Note: This ‘Sound
Recorder’ can then be re-accessed from the lower taskbar].

e Click on the Record button to start a recording. Make your sound into the microphone.
Click on the Stop button when the recording is complete.

e Only edit the sound if you need to. (E.g. you might need to delete a bit of recording just
before or after the section of sound you need). To do this, move the slider on the Recorder
window to identify the beginning and end of the sound, and use the Edit menu on the
Recorder to delete the unwanted sections of recording.

e Select Save As from the Sound Recorder’s File menu. Save as a .wAv file type in the
destination of your choice but it may be best to save it in the same area that stores your
flowchart .flo files.

e To use the sound in your flowchart program insert an output symbol L. Select
Sound from the prompt box and Browse.. for your .wav file and click OK. In the foghorn
example above we wanted the sound to run with the visual fog horn on the mimic and
therefore did not select the ‘Wait for sound to finish...’ in the prompt box.

If we want the sound to finish I [Soundeait "G FLOWOL \Neptunewav™ | oc | cancal ||
before the program continues Turn Output |

[le deSCl"lblng SO meth"’]g] Turn Motor | [V Wait For the sound to finish playing before the program continues

Select ‘Wait for Sound ’ in the I Sound IC:'I,FLOWOL'I,Neptune.WA\-' e, I

Speak Open sound recorder: i_l

prompt box before clicking OK.

e Note: Although flowcharts can run simultaneously sounds cannot. If a sound is initiated
by one routine, then it may be interrupted or cancelled out by sound from another routine.

e When the sound file has been used in a Flowol program and the Flowol .flo file saved, the
location of the sound .wav file is also saved but not the sound itself. If you transfer or
open the Flowol file on another computer you may have to either:

o Transfer the sound file to the location specified by the Sound prompt box or
o Use ‘Browse’ in the Sound prompt box to re-locate the sound file, click OK in the
prompt box to save this location in your program and re-save the Flowol .flo file.
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Using Copy and Paste | =28

Flowcharts can be copied from Flowol3 and pasted into:

e the same Flowol3 application.

e adifferent Flowol3 application.

e aword processor (e.g. Microsoft Word) for a report or worksheet.

Stage 1:
e Drag a box around the section of flowchart to be copied to highlight it blue.
e Click on the copy icon.  paxrmarmmrEm Cicix
: DoWsaein-o- i dEsbaiviaek ]
Either Stage 2: X2 o = i:'”_j =i =
. . X The Light House
e Click on the paste icon.
e Move the gray ghost 2
image to the new place = %
on the workspace and pEW
. .. <> !
click to fix it. T o
OR Stage 2: m ¢!
e Click onthe paste icon ~ — — licd i
in the new application. »« v\ :
e Move the ghost imageto -~ hosti < red it
Oost Image 1S red IT too
the new place on j[he close to other symbols.
workspace and click to
fix it. y 1 o8
it 112314 [5 617 8] Vo 1[0 20 30 4 0 |[ouputs 1 [2]3 &[5 57 5] Moo [A]5 [C [0
ﬁHouse Alarm.flo - Flowaol 3 - Copyright Keep LT. Easy [ [ =
Fle 3Settings Edit Graph  Wew Help
[De@& sm@Bo - fx & OR Stage 2:
x S e Click on the paste icon in Microsoft Word.
- e (Click on the image; click on the ‘Text Wrapping’
- Main Lig icon [ and select Square.
~ | e Drag the image to a smaller size and position it.
-
-~ To copy a mimic into Microsoft Word:
T /ot / Stage 1:
In Flowol, click on the mimic’s title bar; press ‘Alt
W Prt Sr’ and follow stage 2 above.
. |
- Tum Writing about the Lighthouse project
. riting about the Lighthouse projec
. T\ Flowol Mimic x|
-
: ) i 7
After a flowchart has been copied
back into Flowol: £
e Edit the commands in the :
symbols to suit the new context. -
e Note: the subroutine title will ~ ‘ ‘ ,
have Changed automatica”y, since In the Lighthouse perecthantedto show how I
a program must not have two g could control the main light ............... 5
different subroutines with the (
same name.
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Mimic: Mobile

Note: Dilferant options are Controlling Electric Motors

available with this mimic. See p.5 Skill:

Using a Motor output on a mimic.
Changing the speed of a motor.

Electric motors produce movement. This can be the continuous
rotation of a crib mobile or the forwards and backwards
movement of a barrier.

Open the mimic =& folder and select the
Mobile mimic.

Use the left mouse button and click on the
letters on the motor monitor bar

| ot [T M0 | angl observe the effect on
the mimic. When letter A goes green, motor
A should go forward. Click again to stop it.
Use the right mouse button to turn the letter
A red. This should make the motor reverse.

On the mobile mimic, motor A rotates the
whole mobile but what do motors B and C
do? You might like to have the labels on &.

Controlling a motor in a program:

Choose an output symbol (7 to open WP [Tum Motor Afd o ] e |
the prompt box and select Turn unovis | PR e %
Motor.. [Note the 3D mimics have | = | S o T :

written prompt names to remind you |

what the motors do].
( Start ) Select: A (Mobile) Fd [to make motor A rotate forwards] and click OK,.

NO, Turn
Motor A off

Note: More than one motor can be controlled by the same output symbol.

Activity 1: Build up this program which uses input 1 to
control the mobile’s movement.

a

Is Input 1 on

Turn
Motor A fd

Motor Speed or Power Control.

Real motors on models and those on 3D mimics often rotate too quickly. To slow them down we
need to give the motors a ‘%’ speed setting. To do this, select the ‘“Turn Motor A fd” symbol to
re-open its prompt box. Tick the ‘Set motor power’ check box and choose a % speed setting e.g.
50%, before clicking OK.

Activity 2: Now build a program using another input button
to control another moving feature [try forward and reverse].

.. . . | 4 | Turn Motor A fd 50046 [ o | concel |
Activity 3: Edit your program to T Outt | e T ———
change some of your motor speeds. T —Dﬁ—m £ —E‘EI o 3
Add extra output symbols and delays sound_[[° et Off | Fd | e 1o B
to make the mobl_le go fast, then slow Speak | ot |
and then fast again. s0%

Note: Set motor power back to 100% when needed. L M
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Using Analogue Values [VVals] with the Crib Mobile

A switch is a digital input because it can only be either on or off. Analogue sensors on the other
hand have a range of input values e.g. a light sensor can detect variations in brightness and a sound
sensor can detect different levels of noise. [Note: a thermometer is an analogue device].

T\ version Pre- refease 3.0.5218.00 44 ms

When using Flowol in simulation
mode we can simulate changes in
analogue readings by:

e Either clicking on the val reading
on the mimic with the left mouse
button to increase the value in
steps of 5, and by using the right
mouse button to decrease the
value again.

e Or: By clicking on the reading on
the ‘“Vals’ monitor bar at the
bottom of the screen or dragging
its level up or down.

| Vals 1%13 2833 0 4 0 |

Explore the outputs on the mobile by clicking on the output monitor bar. [You will need to look
closely at the mimic since some of the lights on the mobile’s models are quite small].

Activity 4. We will now make the light in the hot air balloon act as a ‘Night-light’ (e.g. the
balloon will light up automatically only when it is dark). For this activity we will assume that
Val 1 is the value from a light sensor on the end of the mobile arm. A light sensor gives a high

reading when it is light and a low reading when dark.

( Start )
W [isva <18
Is Inpuk | 1 wal ;I | Number | 13

2 val
I Is val 3 yal 1= | wal 7lelglcC
Is Variable | + |val I < Variable I 4

I= Margin | >| 1/2]3/48

Build and complete this flowchart to control the light in the balloon.

[Note: After selecting the decision symbol, choose ‘Is Val, 1 < [Number] 18” OK.
When using analogue sensors it is often better to use < or > rather than =].

Run your program and simulate a change in the light level. Now edit your
program to change the threshold value [the 18] at which the Night-light works.

| oK I Cancel |

a

]
o

Isvall < 18

Activity 5: To occupy the baby, create a program to automatically flash the car brake light and
airplane wing tip lights, if the room light level falls below 60 units.

Activity 6: The Automatic Mobile. For this activity assume that the analogue value is from a sound
detector which gives a high reading when it is noisy. Now create a program which brings the mobile to
‘life” if the Baby wakes up during the night and cries. Remember you can control the lights, the
movements and even produce your own sound file if you wish. Perhaps the mobile should become
more active the greater the noise, and then gradually becomes less active and eventually stops.
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Mimic: Big Wheel Controlling the 3D Big Wheel Mimic
[including Speech Windows XP or 2003 only].

Note: The 3D mimics can be re-sized but large
3D images might not work effectively on some
computers. If this happens, re-open the mimic.

Open the Big Wheel mimic [with labels]
Explore what the mimic can do by clicking
on the monitor bars to see the effects of:
Outputs 1, 2 & 3 and Motor A.

|

When motor A is running, look closely at
the input monitor bar and the steps below
the wheel. You should notice that Input 4
IS an input which comes on each time a seat
passes the steps. This is an ‘Active Input’
being controlled by the mimic itself. Note:
clicking on Input 4 on the monitor bar has
no effect.

Now click on Inputs 1 & 2 on the monitor
bar and on the mimic. These are the usual
manual inputs which you can control.

Now click on the gate on the mimic with left mouse button only. You should notice that you
can control the closing and opening of the gate but the gate itself controls the active input 3
which is on the gate post.

Possible Activities

Activity 1
To attract the crowd use the [manual] input 1 to control the lighting effects on the wheel. This
might be a simple on/off routine but flashing sequences are more exciting [use subroutines].

Activity 2
Use the input 2 to control the simple Go/Stop movement of the wheel. You might make the
movement of the wheel speed up and slow down in stages [see Mobile: motor power control].

Activity 3

Modify activity 2 to include the safety feature of the gate: i.e. the gate must be closed before
the wheel can be turned on, and the wheel should stop if either input 2 is turned off, or the
gate is opened.

Activity 4: Using Speech [if you have Windows XP, a sound card and speakers]
To increase safety even further use the ‘Speak’ command to give the passengers an automatic
verbal instruction to “Hold tight please” just before the ride begins to move.

e Select an output symbol and insert it I’ [speakewait “Hold tight please” [ o | concal |
in the program just before Motor A 'is _umoutpu |
to be turned on. Tum botor_|

Sound | [V wait for the text to be spoken before the program continues
I Speak I Hald tight please]|

e Select ‘Speak’ in the prompt box and
type your message in the text box.

e Since we want the message to finish
before the wheel starts, tick the check
box ‘Wait for text to be spoken ...’

e OK
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Using Variables and the ‘Active’ Inputs with the Big Wheel

A variable is a letter that can be e 10
assigned a value: (Let x = 10).
Variables can be added to or it
subtracted from: (Letx =x+1).| ="
Variables can be subtracted etc.

(Let X = x-y). | 7Y

A variable can be checked in a

Decision symbol.
With the Big Wheel mimic we can use
variables to:

e Count how many times the ride is used.

e Control the length of ride.
e Change the speed of the motor smoothly.

Activity 4: s )

Use variable ‘x’ to count how many times the ride is used. Build this

Counter
‘Counter’ program to run alongside your Wheel program. The counter
increases the value of the variable ‘x’ by one, each time Input 2 goes on. Let x = 0
To open the Variable’s W [fetx=0 [ox ] con |
window, click onthe =~ —=i; -| B 1
| = P Sub E = al | 7lalalc
. icon. l S e ento| 4lsle]. Is Input 2 off
|
Yariable | Yalue |
E g 'lLetx Xx+1 — . oK I Cancel
EI g Delay g - Numberl E - ITI Mumber |1
n ] c = vl ||c - | werisbie | 7|8 |8 |C
= 12 I d ariable d I3 4158
¥ o 5 = = 1220
z ] : = : =
-
letx=x+1
Activity 5: Stopping the wheel automatically. |

Construct a similar counting program to increase the variable ‘y’ each time a seat passes the
steps i.e. each time the ‘active’ input 4 goes off and on.
Since there are seven seats, each full rotation of the wheel should increase the variable ‘y’ by 7.

Now modify your program, by introducing a decision symbol, to stop the wheel automatically
after it has rotated 3 times

' I Isy > 20 OK I Cancel |
Is Input | b _I _I I Mumber I 20
T | '_—I 4| 2083 c — o
I Is Variable ; ‘ariable 4 Es
¥

Is Margin |_ 12030

Activity 6: [Extension]

Now that you have learned how to use Input 4, modify the program so that each of the seven
seats stops automatically at the bottom for a short time for the people to get off. [Note a
variable is not needed for this solution]
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Changing the speed of a motor with a variable

Many fairground rides produce a thrill by the rapid change in movement, but the Big Wheel is
not one of these. To keep passengers safe the wheel should speed up and slow down gradually.

( swspeeduwp ) This is possible by building subroutines like this one, which keeps changing
the % speed setting of the motor. Such flowcharts can become rather long.

Turn Motor Turn Motor Turn Motor etc
/Afdm% A’ Delay 0.2 —/ A fd 20% /LD Delay 0.2 47/Afd30%/L’ Delay 0.2

ACthlty 7: ( SubSpeedUp ) ( Sub Slow Down ) ( Start )
Changing the speed gradually by using a
variable gives a more compact procedure.
We use the variable ‘a’ to represent the leta=0 letaca-
speed/power of the motor and then change
the value of this variable.

leta=a+10 / Turn Motor
- - - - A f 0/
Build these two subroutines first, and then da%
the main routine.
| 4 [ Turn Motor & fd 296 ok I Cancel Turn Motor Do 5
Turn Output |[(A Wheel O I Fd _fe T — A fd a% elay 0.
E  Matar 0if Fd |_Fe
| TurnMotor | ¢ motor Qff Fd | _Fe ) j' L
D Motar 0ff Fd |_Fe 50% -
Sound | PR 1
[ee= ] o ]
10% Delay 0.2 ISub Slow Down

b -
Select the Set motor power check box and —

scroll down to the variable % setting.

Tumn
Motor A off

Note: If configured for FlowGo you can only use motor
speed variables if you uncheck the ‘Limit features’

option in the interface dialogue. FlowGo cannot work @

remote and only the ‘X’ or ‘y’ variable can be used.

ES

When the program is running, look closely at the motor monitor bar at the bottom of the
screen. The shaded area of the monitor label indicates the power level of the motor.

MotorNA B [ [D |

Using the ‘Stop AIl’ in an emergency.
In the wheel Activity 3 earlier, we suggested the use of the

gate as a safety feature to turn the ride off if the gate was
opened.

( Start )

Flowol also has a ‘Stop All’ feature which stops the whole
program. The program then has to be re-started by the
Start/Stop button on the toolbar; i.e. the whole system is
shut down, and can then only be reset by an authorized
person.

Is Input 5 on

This routine uses Input 5 as an emergency shutdown /
button which could be added to the Wheel program.
Trigger this by clicking on Input 5 on the monitor bar.
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Mimic: Railroad Crossing

:I Secondary

Controlling a motorized barrier

A motorized barrier or garage door moves in one direction for a certain distance and then has to
move in the reverse direction by the same amount. Deciding the length of time the motor

should be turned on for, can be determined in two ways:
e Either by having a feedback switch to turn the motor off when the barrier has reached its

final position.

e Or by considering the speed of the motor, the distance the barrier has to move and the delay
time needed while the motor is on.

In this example we have two subroutines, one which closes the barrier using a feedback switch
and another one which opens the barrier using a delay. These subroutines are then controlled

by the main routine.

Gate in normal
open position

( Sub gate close )

(' Sub gate open )

.

Main routine

( Start )

Motor closing

the gate W - ] /‘/f}fr W
Turn Motor
A fd 70%

Is Input 3 on

Turn Motor = Is Input 1 on
A

A rev 80% ] “‘% Ly @%J
Delay 2

ST Delay

-
m - 1
Motor A off Motor A off oo |

( Stop ) ( Stop )

When using this 2D barrier mimic, you need to click on the gate post ‘hot spot’ to simulate input 3
being turned on. When the barrier opens however, this switch will ‘spring’ off automatically.

1)

Sub gate close

Switch detects the
ES closed gate

—
c

Is Input 2 on

Turn

Sub gate open

L

A good extension in the ‘Railroad Crossing” example, is to use this gate switch [Input 3] to control
the red and green signal lights which are pointing towards the train. This ensures that the gate is
indeed shut before the train is given the green light.

If you have checked all the inputs on this mimic by clicking on the input monitor bar you may have
noticed that input 4 is a switch on the hinge post [not labeled on the mimic]. This can be used in a
similar way (e.g. as a feedback switch to detect when the barrier is fully open).

Using Animated 3D Mimics
Some inputs used on the new 3D mimics are triggered by the animated part of the mimic itself and
are not ‘hot spots’ and therefore cannot be ‘clicked on’ by the user (e.g. ‘Big Wheel’ example).

;l © Keep I.T. Easy 2008 =
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Controlling the Auto Home

Mimic: Auto Rambler

Analogue sensors detect a range of values e.g. a light sensor [LDR] detects variations in brightness
and a temperature sensor [thermistor] detects variations in temperature.

When using Flowol in simulation mode we L X
can create simulated changes in analogue
readings by:

e Either clicking on the val reading on the
mimic with left mouse button to increase
the value in steps of 5 and using the right
mouse button to decrease the value.

e Or by clicking on the reading on the ‘Vals’
monitor bar at the bottom of the screen or
by dragging the value up or down.

| vals 118 2fBag3[ 0 4 0 |

To use the ‘Vals bar’ more effectively, it can
be dragged into the workspace [making it a
window] and then placing it just below the

mlmlC > Yals: 1’?2'? 3’T 4|T

In the mimic shown: Val 1 is the outside temperature reading and Val 2 the outside brightness.

>>>>>>>>>>>>>>>>>>>>>>>>

Activity 1: Electric Fire
Use the temperature value [Val 1 in the decision prompt box] and build this
flowchart to control the electric fire. [In my example the fire is output 5].

.. . Temp.
Activity 2: sensor
Construct another routine to control the fan when it gets too hot.
Activity 3:

Build yet another similar routine using the outside brightness [Val 2] to
control the inside lamp.

Automatic blinds Activity 4: First build
( Start ) two subroutines,
BlindCl and BlindOp,
which make Motor B
go forward and reverse
[similar to the Barrier
example earlier].

Fire [ES

Turn
Output 5 off
Turn
Output 5 on

Activity 6:

Outside Security Light
The digital sensor above
the garage door can act as
a security sensor to detect
a person nearby. Use this

A

Night Security Light

&
<

IsVal2 < 40

Now build this main
routine using the light
level from Val 2 to
control the blinds.

Sub BlindCl

IsVal 2 > 40

Activity 5: Now try sensor to control the night
controlling the garage security light above the
door in a similar way front door.

Sub BlindOp using inputs 1 & 2.
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Changing the size of the Workspace — Printing multiple pages

| File settings Edit mimic
Chrl+n
Chro
Chrl+s

Mew
Qpen...
Save
Save As...

>

Page Setup...

Print Preview
Print...

Ctrl+P

Exit

The workspace has a default size of four Letter sheets of paper in a
portrait block, which can hold about 220 flowchart symbols.

Page Setup

Set the F\owol wor)space d\mens\ons N | Brinfer Page

whide: |2

=

™ show page boundaries.
¥ Reduce to a si

ingle printed page when printed.

=

ok | Cancel

To check the workspace size, open the ‘Page Setup’

window from the file menu, tick [check] the ‘Show page
boundaries’ box and press OK. Now Zoom the Flowol

workspace to 30% to show the pages available.

Page Setup
ctup... || —

2%

1~ Paper
Size.

Source;

R

|Automal\cally Select

= |

[~ Drientati

o Margins finches)—————————
& Portrait Left 1 i
© Landscape Top: 1 Eotigy

—

Eight:

Eottom: |1

[ o ]

Cancel | Erinter.. |

To change the workspace size: open Page Setup. The default workspace size is four
pages [2 Wide and 2 Tall]. To change the workspace size, change the dimension settings and

press OK.

Note: Increasing the workspace might be needed for very large programs particularly when
other flowcharts are pasted in from other Flowol applications. The workspace however,
should not be increased unnecessarily since printing on a single sheet becomes less effective.

Printing the Flowchart =

L

The default printer setting reduces the workspace to a
single page when printed, in portrait e.g.:

e If the flowchart only occupies sheet 1, then this sheet
will be printed on Letter with the flowchart symbols at

100%.

e If the flowchart also occupies part of sheets 2, 3 or 4
then all four sheets will be printed out on a single page
with the symbol sizes reduced appropriately.

e If the flowchart only occupies sheets 1 and 2 then it
might be useful to open the ‘Printer Page Setup’
window and change the orientation to Landscape.

e Note: If the workspace size has been increased above
4 pages, single sheet printing might be ineffective as
the symbols and text may be too small to read.

Multiple Page Printing: To maintain 100% size of the
flowchart symbols when printed, print the workspace
sheets separately i.e. un-select the ‘Reduce to a single
printed page when printed’ on the Page Setup window.

Pages to be printed can be viewed in the ‘Print Preview’ opened from the file menu.

Keyboard shortcuts ‘Hot Keys’ can be used to build instructions in the symbols. To label

the Hot Keys, select ‘Display keyboard shortcuts. ..’

in ‘Options...

’; Settings menu; OK.

The letters underlined in the prompt boxes e.g. Output, Motor I [Turm output 2 on
etc, refer to the keyboard keys that can be used instead. Some [Tungues 1
instructions have different letters e.g. ‘off” and ‘on‘ are No and _tumt |

Yes. OK is Enter. [Use Alt & shortcut, to avoid textboxes].

Cukpuk ]l On [ |
Cukpuk ]l [ an v
3 Output QU M1 0 O ]
4 Output QU M1 0 O ]
soud |5 output Off IN1|_On ]
Speak | 6 Output QU M1 0 O ]

;l © Keep I.T. Easy 2008
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Monitoring the System and Logging Data

Mimic: Greenhouse

Monitoring a system is more exciting when an interface is connected and the real conditions are
being observed, but it is still impressive when the system is being simulated. For either of these
modes, however, calibration is needed and therefore we need to set Flowol for an interface.

To set Flowol for an interface: 2% Flowol Mimic X
Settings menu — Interfaces — select the o
interface you are using or choose 5

Contact Controller Plus or Deltronics

Serial Interface Plus for the maximum 7 e UL 6 |

inputs and outputs — COM 1- Save Wl’

settings and OK. [T ___‘4'/
- - frmsss o | lI:: |

For simulation mode, keep = - the | ;

interface connection open.

When configured for an interface, the
Val monitor bar [or Val window] gains
drop down menus.

Use these drop down menus to choose
the appropriate sensor calibration

vais
vas 125 Zesand 0 4 0

(e.g. for the Greenhouse mimic: Val 1 - Temperature and " val(percent)

Val 2 - Light). If you now drag the temperature reading i Temperature (degrees C)
. . . Termperature (degrees F)

the monitor window you may have a different range. v Light (percert)

Pasition {percent)

anale {deqrees)

Showing and Setting up a Graph kil voltage (volts)

Clicking on ‘Show graph’ icon gives the first graph window.
This has a side menu bar allowing you to select the data you

wish to log. . . . .
g e x| The time axis has the default setting for 2 minutes
TN | | which keeps doubling up.
Yal 2 (percent) Add axes by clicking
yal 3 ((ruil) Dndthﬁ bu_ttons ;D the Inlef't
val 4 () anel ehocsng what to pot When one set of axes have been opened two
Tput 1 I ] further side menu buttons appear so other axes can
Input 2 <+— Menu bar
Input 3 be selected.
Input 4
Tput 5 x|| The button on the graph
ot M Femp ey |- title opens the
Irput 8 o ‘Properties’ window for
oupett those axes.
ukpu
Output 3 40 x|
Oukput 4 Appearance
Qukput 5 » -
OEtEEt & 4 1 L
Qukput 7 € Use default axis name
Qukput & 204 + Specify axis name: | Temp {deg C)
Mokor & s -
Motor B 10 I Eill area below trace
Mokor C Analogus
Mokor D | 0 | , " Use default Y¥-axis range
» 0 2 rin 4 % Specfy ¥-axis mn: [0 ma;:ISU
Cancel |
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Detailed Setup of Graph Windows

Logging Settings. Open the Logging Settings window @

The time axis default setting starts with a logging duration of 2 =
minutes which keeps doubling up forever. Logggienal [T friiseconds <]
To specify your own total logging time: change the logging £ Specfy atotal Ingging duration
interval and the logging duration independently. Note however, i st fiendees -
that Flowol can only log up to 20,000 samples. O i

Iritial view: 2 |rirutes =l
The frequency bar chart for inputs is initially set at 10 columns,  here wilbe 1200 readings made.
but this can be changed. T tiumber of iput requency colamns: [10
Returning to the default settings can be done by choosing showoera | [ ox | cocel |
‘Show Default’

Open a graph window by selecting B Show graph’ [Note four separate graph windows are available]

Open the left hand side menu and select the data to be logged. When one set of axes have been
opened two further side menu buttons appear for other axes to be selected.

x|
Val 1 {degrees <) . . .
e e bt e e This example has two sets of analogue data, one Output [Light] and

BCHCUNIN (i three Input switch frequencies being logged.

Input 1
Input 2 -
Hhivs 2 Flowol Graph 1 [l The number of sets of axes and the data
Input 4 » - Properties... - H H
s | 2 [Temp(degc) [~ Llght(w) — displayed on those axes is your choice.
Input 6 Remowve
Input 7 40 —‘\

Input 8 ~

The axes can be removed or the ‘Axis

output 1

i o Properties’ window opened from the
s " dropdown menu by each title.
Cutput 6
Cutput 7
e - = The name for the
r x| .
i 7| [insice Light - J— temperature axis has
(R — |l 1] T AN | 1 Grid: IFme 'l been ChanQEd
1]
_p " 2 min " Use default axis name
T (?:arage Dioor |'I Input 2 |'|_ % sSpecify axis name: ITemp|(deg ] The range Of Values to
requency . .
2 coocr: [ be displayed i.e. the

I Fill area below trace

max. and min. has also

Analogu -
0 e Else default ¥-axis range been SpeCIfIEd-
L . % Specify Y-axis min: I 10 max: |4D
= Clicking on a title bar

- Cancel | d f h b
ppearance efines the axis to be
rd: [Fine | displayed on the graph.

= Use default axis name

o Specify axis name: I Garage Dnnr|

coour: | The Axis Properties of input 1 has been specified to display as a
¥ il area below troce frequency graph and the namef/title of input 1 changed to
Inputs ‘Garage Door’

[V Display input Frequency bars
" stack bars

Note the data from the three inputs can be stacked or displayed

o] o | adjacent [as shown].

( Flowol > ;l © Keep |.T. Easy 2008 = »(__ Page2r )
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Multiple Graph Windows

Additional graph windows can be opened from the Graph menu, or by selecting kil again
from the top toolbar.

Note: Up to four graph windows can be opened, each having multiple sets of axes.

When carrying out an investigation it might be appropriate to have the graph windows
displayed around the mimic so the visual information is in a realistic context.

|
el The whole graph window can be ‘dragged’ to
e : change its size and the boundaries between the

-100] T
e —t— graphs also dragged up or down to change the
- om relative sizes of the graphs.

0 60 sec 2 min

|Temp (degrees C) |~ XII
w 5I

1 Erightness >

100

vl -

20

a0
20

60

Lx 1
o3
=
z

40

20

[1] 60 sec 2 rin

Inside Light -
I | .
c in

Sprinkers

{

Graph Values. After opening a graph window click on the Graph Cursor icon =3

x||  The vertical cursor line can be dragged
Y 233degessC |+[EBSpercent v 2i14min across the graph to scan the values at the
100- various times.
a0+
| e The corresponding readings are given in
a] the title bars of each graph.
201
This is particularly useful to identify the

0 2 rnin < rnin

maximum and minimum readings for
analogue values, or the length of time an

| uUlJ—Ll—LI—-TFJ—_l:_ output device may have been turned on.
(__Page2s ) »| ©KeeplT.Easy2008 | »( Flowol )
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Tutorial

Transferring Graph Data and the Graph Windows

Graph “iew Help

Logging Opkions. ..
v Log on Run
Show Graph Cursor

Save @raph Data. ..
Open Graph Data. ..
Export raph Data. ..
Copy Graph

Prink Graph

2
3

Graph Window 1
Graph Window 2
Graph Window 3
Graph Window 4

[| & & | B o

Open the ‘Graph’ menu.

Note: ‘Log on Run’ will normally be selected so that
graphical data is logged by default. Deselecting this will

mean that no data is logged.

Saving and Opening Graph Data from Flowol and then back into Flowol

uses a Flowol graph data [*.flogdata] file.

Note: It is advisable to always save graph data even if you then wish to

export it.

Exporting Graph Data for other applications can be saved as either *.csv, *.tsv or *.sid files.

CSV - (Comma Separated Values) — This is the best format to import the data into a spreadsheet

or database.

TSV - (Tab Separated Values) — This is useful to import the data into a word processor as a table.
SID - This type of file can be used to export the data to other graphing applications e.g. Insight 2.

Copy Graph: to copy the graph window into another application.

| Graph Wiew Help
| Logging Cptions. ..
' w Log on Run

Show Graph Cursor

Choose ‘Copy Graph’ from the Graph menu. Select which

[ & = ke

Save Graph Data, ..
Open Graph Data...
Export Graph Data.. .

Copy Graph
Print Graph

Graph Window 1
Graph Window 2
Graph Window 3
Graph Window ¢

Copy Graph 1
Copy Graph 2
Copy Graph 3
Copy Graph 4

graph window you wish to copy.

from the Picture toolbar and select Square.

Open the second application e.g. Word, and paste the graph
window.
To re-position the graph window:

e (Click on the image; click on the ‘Text Wrapping’ icon IE

Drag the image to the required size and position it.

Print Graph: to print the graph window directly.

| Graph Yiew Help
; Logging Cptions. ..
' v Log on Run

Showe G@raph Cursor

window you wish to print.
If the graph window only has a single set of axes, it will
print on the top half of a sheet of paper in portrait.

Save Graph Data...
Open araph Data. ..
Export Graph Data. ..
Copy Graph

Print Graph

]

Graph Window 1
Graph Window 2
Graph Window 3
Graph Windaow ¢

Print araph 1...
Prink Graph 2...
Frink Graph 3.,
Erint Graph ...

[ &= = o

Choose ‘Print Graph’ from the Graph menu and select the graph

If the graph window has multiple axes, it will print over the

whole sheet of paper in portrait.

To print graphs in landscape choose Properties... on the
Print dialogue that opens when using the Print graph option.

[Note: this will also change the page size and orientation of the flowchart
printing since Flowol only communicates with one instant of the printer
driver].

Note: It is often more flexible to copy and paste the graph
window into Microsoft Word [as above] and print the graph
from that application.

;l © Keep I.T. Easy 2008 =
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Other situations using variables

1. Counting cars entering and leaving a
parking area

The two barriers of the parking garage are
controlled by each having two subroutines
and a main routine [see motorized barrier].
If we assume there are ‘x’ spaces available
[e.g. maximum of 5], we need to count this

( Sub In Down ) ( Sub Exit Down ) ( Start )
Turn Turn
/ / Motor B rev / Letx =5

Motor A rev

variable ‘x’ down when the ‘in’ barrier
closes and use the closing of the ‘out’
barrier to count ‘x’ up when cars leave.

e The ‘Full’ sign can then be triggered by
this variable in a separate flowchart.

e The value of the variable can be observed
by clicking on | to open the Variables
window.

( Start )

Controlling the 'FULL' sign

NO, Turmn
Output 8 off

If there are fewer places
than one, then the
car park is full.

Turn
Output 8 on

2 Repeating a Subroutine
Beep at a pedestrian crossing.

( Sub Beep )

Letx=10

Flowol can define the repetition
of subroutines from the main
procedure

e.g.

Delay 0.5

i Sound "Beep" ;

letx=x+1

Sub Beep x 9

Subroutines can also be
repeated by increasing a
variable as shown by this
flowchart.

ES

v
=z
O

a

Delay 0.5 Delay 0.5
Turn Turn
Motor A off Motor B off

letx=x-1

letx=x+1

( Stop ) ( Stop )

To make the parking garage most effective, the
‘in’ barrier should only open if there is a
parking space. The master ‘in’ program

< therefore needs an AND situation created by two
decision boxes. (Is input 1 on AND Is x > 0).

3 Having a delay which
can be interrupted

A fairground ride should
have a specific run time, but
it should also be possible to
stop it at any time.

This subroutine counts up
the variable ‘y’ at one
second intervals for 9
seconds [until: Isy > 8].
But if Input 2 goes off then
this 9 second delay is
interrupted.

NO

Is Input 1 on i

Sub In Up

Is Input 2 on

Sub In Down

( Sub ride )

Lety=10

Delay 1

lety=y+1

Is Input 2 off NO

ES

( Stop )

4 Main routines running simultaneously but being interdependent. A variable set in one
main routine can be used to trigger another routine. (e.g. in a conveyor belt process each process
must not start until the conveyor has stopped). The separate processes run simultaneously but may
take different times. When each process has finished a variable is set and only when all these

variables have been set can the conveyor start again.
[E.g. The Jam Factory Mimic example: More Secondary Mimics 1]
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1

Solar Water Heating Panel

Resources SKill:

val 1 and val 2 — temp. sensors " o compare two analogue

Motor A — water pump inputs (a comparator).

val 3 and val 4 — light sensors Use the ‘Marein’

Motor B — 6V motor (turntable) g
Temperature Control: (" sar ) ( swwes ) Sub east

The flowchart below will only pump the water
if the panel temperature [val 1] is hotter than
the temperature [val 2] of the water in the tank.

Sub west

Sub east

Sun Seeker:
The flowchart on the right will
control a motorized turntable.

The two light sensors on the front of
the panel need to be separated by a
piece of card to cast a shadow.

The ‘Margin’ refers to the difference
between the two analogue values. i.e.
the difference has to be at least 5 units.

Turn
Motor A off

ES
Turn Motor
B fd 20%

Turn
Motor B off

Turn
Motor B off

B8 Flowol Graph 1

Data Logging and Control.

( Stop )

Solar Panel (deg C) |"|Water Tark (deq.

The ‘cause and effect’ is
easily demonstrated by using
Flowol Graphs:

4

.

204
k
20

a. The pump motor A
responds to the temp. 0
difference. — 1] B0 sec 2 min
|Water Purnp |v
b. The ‘Sun seeker’ Mo 00
motor responds to the -100] _
. . . — 0 Bl zec 2 min
light differential.
|Turntable motor |
. ; ¢ 009 R — N
Note: The light graph has | _mg - . = -

been left as %.

Light sensor |+ JLight sensar

The temperature sensors have
been calibrated and then the
temperature range changed

[i.e. limits between 0 and 40].  »

1004

S0

Save your Program

WWW

|-

Bl zec

2 min

;l © Keep I.T. Easy 2008 =
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The Robot Project

Resources

Robot: which has two wheels each driven by separate motors.
Motor A [on the left] — 6V motor

Motor B [on the right] - 6V motor

Input 1 — “buffer’ switch on the front.

Skill:  Nesting Subroutines.
Controlling motors in the
same output symbol.

1 The movements Of a rObOt can be ( Sub forward ) ( Sub stop ) ( Sub right ) ( Sub left )
defined by subroutines.

2 Each output box (symbol) can
control all the motors if you wish. Tum Motor Turm Motor Tum Motor Tum Motor

A fd B rev B fd A rev

3 The power control has to be the A/B fd 100% A/B off 40% 40%
same for all the motors in the
same symbol. Note: if power is
40% in one sub., then it stays at (sw ) sop ) Delay 2 Delay 2
that value until it is re-defined.

4 Build these subroutines and also one for reverse.

5 The delays in the ‘right” and ‘left” will have to be tested for ot v
your particular robot and the motor power control chosen.

Obstacle Course:

( Stop ) ( Stop )

1 Build a master program to define the path needed to be taken around a course.
2 An emergency stop, similar to that on the Big Wheel ride, could be triggered with a ‘buffer

switch’ [Input 1] on the front.

( Start ) ( Sub avoid )

Random Mover: (Cleaning the rug!)

1 Build a subroutine of the movement needed when the
buggy hits an obstacle. [The one shown is only one
possibility]. Note: Sub stop, is nested in Sub avoid.

2 Build the master program to trigger this routine.

3 You could have two different switches on the front!

( Start ) <«—— This flowchart could
be one version of a
line follower. The
Turn Motor
B fd A off
Turn Motor
A fd B off

a

light sensors inputs 1
and 2 would have to
be on either side of a
dark line.

It might be an
improvement to use
analogue sensors and
compare their values
as explained in the
Solar panel.

Is Input 1 on

Turn
Motor A,B fd

(__Pages2 ) :! © Keep |.T. Easy 2008 !

v

Turn
? Motor A,B fd / Sub stop

Is Input 1 on

Sub reverse

Sub avoid Delay 2

L

Sub left

( Stop )

Save and Print your programs.
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Installing Flowol 3 on a Windows Network
The Flowol 3 software comes with a Windows Installer on the CD ROM. When you insert the
CD ROM into a workstation, most likely the installer will run automatically and the on screen
instructions will allow you to install the software onto that machine.

The installer copies the Flowol 3 program to the hard disk of the computer and creates a set of
registry entries. Flowol 3 must be installed onto every workstation on which you want to use
Flowol 3. It is not possible to run Flowol 3 by copying it to a central server and running it from
there.

You do not need to manually install Flowol 3 on every machine by hand! Read on!

A Windows Installer Package (.msi file)
We have built the Flowol 3 installer as a Windows Installer 2.0 package (an .msi file). This file
is called Flowol310.msi on the CD ROM. To see the Flowol3.msi file:

e Insert the CD ROM into a workstation.

e |f the automatic installation starts, cancel it.

e Open My Computer:

2 My Computer

File Edt View Favortes Tools Help "

Qe=-Q & /'f‘lsEar:h [ Folders | [FE1)+

acddress | 1§ Py Computer v B

Files Stored on This Computer

// Shared Documents // Anthory's Documents

Hard Disk Drives

System Tasks £

View syskem information
T Add or remove programs
3 Change a setting

&3 Eject this disk

Other Places w Local Disk (C:)

&3 by Metwork Flaces
[} My Dacuments Devices with Removable Storage

[ shared Documents

@ Control Panel \"H 3% Flappy (4] £ AutoPlay

= Search...
Details St
Explore

e Right click on the CD ROM drive (has the Flowol 3 icon) and choose Open:
[E[=1[ES)
File Edit Wew Favorites Tools Help &

Qe - (D - (T | O seann [ roders [T~
address [ e\ v B

: 0 — "3, Adtarun.inf
File and Folder Tasks 2 /’ FlowGo5ololSE : Setup Information
| 1k8

) Rename this File
B Move this file A, FaTutarialpof
obe Acrobat 7.0 Document
/gl Adobe Acrobat 7.0 D k
Mm| 2,384 KB bm Icon

) Copy this file

&8 Publish this file ta the Web e 11 e

e ﬂ e
[T vicrosoft Corparation EMlcmsuftCuruwatmn

e Note the Flowol310.msi file. If you have your workstation configured to hide file

extensions, then it may just be listed as Flowol3, but have the same icon as shown above.

Flawlcon.ico
16z 16

%

Other Places wl

Deploying .msi files

In most cases, networks in schools come with a piece of administration software which will take
the Flowol310.msi file and deploy it across the network to your chosen workstations. Check
your network documentation for information on deploying Windows Installer Packages. On the
following pages are instructions for RM networks, and installing with Windows Group Policy.
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Installing Flowol3 onto the RM Community Connect 3 network system
Only the site license version of Flowol 3 should be installed onto a network.

For updates and corrections to the information given here, look on the web at
http://www.flowol.com/Flowol3/RMConnect3.aspx
[You can follow along in the Community Connect 3 Reference Manual, Chapter 7, section
entitled ‘Deploying a Non-Curriculum Choice Windows Installer Package’, page 101]
[Creating the folder structure on the server]
1. At aworkstation, log on as a system administrator.
2. Browse to Q:\Applications. In the Applications folder, create a new folder and name it
Flowol3.
3. In the newly-created Flowol3 folder, create another folder called Shortcuts. In the newly-
created Shortcuts folder, create another folder also called Flowol3. Thus you have
created the folder structure Q:\Applications\Flowol3\Shortcuts\Flowol3.

[Copying the Windows Installer package to the server, page 102]

4. Copy all of the files from the Flowol3 program CD Rom into the first Flowol3 folder you
created, i.e. into Q:\Applications\Flowol3.

5. Inthe RM Management Console, select the Workstations option, right-click Main Site

and then choose Update Package List.

Right-click on Workstation and choose Properties.

Select the Packages tab at the top of the dialog box.

In the list of Available Packages, choose Flowol3.

Click Allocate and then click on OK.

0. Restart the workstation to install Flowol3 onto it.

2O ~No

[Copying shortcuts to the server]

11. Log on again to the same workstation as system administrator.

12. Locate the Flowol 3 shortcut by browsing to C:\Documents and Settings\All Users\Start
Menu\Programs\Flowol 3.

13. Copy the Flowol 3 shortcut to the folder you created at
Q:\Applications\Flowol3\Shortcuts\Flowol3

14. In the RM Management Console, Resources, Program Sets option double-click on Data
Logging & Control.

15. Select the Shortcuts tab at the top of the dialog box.

16. In the Source list, choose Flowol3.

17. In the Available Shortcuts list, choose Flowol 3.

18. Click “>’ button and then click on OK.

You can now deploy the Flowol3 package to different workstations on your network.

If you are going to use the FlowGo or SOLO interface via the USB port, when you plug the
FlowGo/SOLO into the USB port on the workstation, follow these steps:
1. When asked for the Administrator password, make sure you provide the correct domain.
E.g. RMTRAINING\SystemAdmin
2. Wait for the Found New Hardware dialog
3. Choose the default option, Install Software Automatically.

(__Pagess ) »| ©KeeplT.Easy2008 | »( Flowol )
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Windows 2000 or 2003 Server Network via Active Directory/Group Policy
Microsoft provides automatic deployment via Group Policy. For information on Group Policy
see http://www.microsoft.com/windowsserver2003/gpmc/default. mspx

To install Flowol 3:
1. Logon to the Windows 2000, or 2003 server machine as an Administrator.
2. Create a network share on the server and copy the Flowol310.msi from the CD.

Then (without the Group Policy Management Console):

3. Click Start, Programs, Administrative Tools, Active Directory Users and
Computers.

4. Right-click the organizational unit to which you want to apply the package, and then
click Properties.

5. Click the Group Policy tab.

6. If you have an existing group policy, skip to step 7. If you need to create a group
policy, click New, type a descriptive name for the group policy, and then press
ENTER.

7. Click the group policy, and then click Edit.

Or (with the Group Policy Management Console):

3. Click Start, Programs, Administrative Tools, Group Policy Management.

4. Expand the Forest and Domains tree nodes to show the domain node of your domain.

5. Click on the domain.

6. If you have an existing group policy, skip to step 7. If you need to create a group
policy, right click the domain and choose Create and Link a GPO Here..., type a
descriptive name for the group policy object, and then press ENTER.

7. Inthe right hand pane, right click the group policy object and choose Edit.

And finally:

8. To deploy with a computer-based policy, double-click the Computer Configuration
branch to expand it, double-click Software Settings, right-click Software installation,
point to New, and then click Package...

9. Browse to the network share that contains the Flowol310.msi package, choose the
Flowol310.msi package, and then click Open.

10. When asked which deployment method to use, choose Assigned and then OK.

Installation using the msiexec.exe command line [Advanced users only]

If you’re familiar with logon scripts and batch files, you can call the Flowol 3 installer from the
command line using msiexec.exe. Command line arguments for msiexec.exe can be found at
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/command_line_options.asp

To run the setup with the user interface call
Msiexec.exe /i D:\flowol310.msi
To run the setup silently, call
Msiexec.exe /i D:\flowol310.msi /gn
(Note this will result in the restart happening automatically)
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Flowol 3 Index and Glossary

Calibrating: The program needs information about the type of sensors being used on the
analogue inputs so that appropriate readings can be displayed. If Flowol has been set/configured
for an interface, click on the down menus on the ‘Val’ monitor bar and choose the appropriate
sensor [p.26].

Colors: The colors of the flowchart symbols and lines can be changed to suit the user. To do
this, select the Settings menu - Options... - Colors (Note: strong colors may be useful for
demonstrations but strong flashing colors can be hazardous) [p.13]

Com: The value of the Com needs to be selected when using the Serial port, so that the computer
can communicate with the interface [p.5].

Configure: Flowol is normally set/configured assuming it is not connected to an interface.
When you wish to use an interface you need to re-configure Flowol [p.4].

Copy Flowchart: Highlight the appropriate section of flowchart and click on the copy icon on
the top toolbar. To paste the flowchart back into the same application or another Flowol
application, click on the paste icon, move the ghost image to the new position on the workspace
and place. To paste into a word processor, position the cursor and select the paste icon [p.17].
Copy Graph: Choose ‘Copy Graph’ from the Graph menu. Paste.. etc [p.29].

Data Logging: Information from sensors can be displayed on graphs, saved and re-opened or
exported to other applications [p.26 — 29].

Decision symbol refers to information, and decides if ‘Yes do this’ or ‘No do that’. The
information might be a switch turning on or off, or the light or temperature levels changing, or a
variable reaching a specified value i.e. ‘Is Input 2 on’ or ‘Is Val 1 > 25’ [p.14].

Digital inputs can only be off or on e.g. switches, pressure pads etc [p.14].

Edit (hand) tool is needed to highlight a symbol, line, label or section of flowchart so it can then
be erased, changed or moved. (Note: Using the right mouse button is a shortcut to the edit tool)
[p.10].

Erase tool, allows a highlighted symbol, line or section of flowchart to be removed [p.10].
Exporting: Graph data can be exported as SID, CSV or TSV files for other applications [p.29].
Feedback occurs when some change in the controlled system is detected by the inputs, which
then alters the behavior of the system. E.g. when a moving barrier hits a switch which then stops
the movement [p.23] or a temperature sensor controlling a heater, turns the heater off when it
gets too hot [p.24].

Flogdata file is the Flowol graph data file for graphs which can be re-opened back into Flowol
[p.29].

Flowchart is the group of instruction symbols connected in the right order to create the Flowol
program [p.9].

Graphs: Digital and analogue data from inputs can be logged and displayed as bar charts [p.27]
or line graphs [p.26-28] respectively. The response of the outputs and motors can also be
displayed on the graphs. The information can be exported as SID, CSV or TSV files [p.29] for
other applications or a flogdata file to re-open back into Flowol. The graph window can be
opened by selecting the ‘Show graph’ icon [p.26].

Graph values: A vertical cursor can be scanned across the graphs to display the values at
particular times [p.28].

Grid (from Properties.. on graphs window) allows the number of grid lines to be changed on the

graph [p.26].
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Hot Keys: Some letters in the prompt boxes are underlined e.g. Output, Motor etc, which

refer to the keyboard shortcuts which can be used instead of using the prompt box. Some
instructions have different letters e.g. ‘on’ and ‘off ‘are Yes and No. OK is Enter or Return

[p. 25].

Inserting symbols: Another symbol can be inserted automatically in a vertical flowchart. Place
the new symbol on the flowchart line in the correct place [p.10].

Installation is needed to get the Flowol program from the CD on to your computer [p.3] or
[p-33].

Interface: These are the control boxes which transfer the instructions from the Flowol program
on the computer to the real devices being controlled. Several different Serial and USB interfaces
can be used. The interface window can be opened by choosing the Setting menu and
Interfaces... [p.5].

Labels: Select the Text Tool ‘T’, position and click the ‘window’ on the flowchart. Write the
label in the text window. Use the font toolbar to vary the style [p.10].

LDR is a Light Dependent Resistor and is the usual type of light sensor [p.14].

Lines are used to link the symbols together to create the flowchart. Select the line from the
toolbar. Click on the symbol you want it to start from, and then click on the symbol you want it
to go to [p.9]. When a decision symbol is being connected, then both a YES or NO decision has
to be made [p.14].

Log on run (in Graph menu) will normally be ticked so that graphical data is logged by default.
Un-ticking this will mean that no data is logged [p.29].

Margin refers to the difference in reading between two analogue sensors e.g. ‘Is Val3 > Val4’
and ‘Is margin > 5’ [p.31].

Mimics: These are controllable pictures which allow the control solution to be tested in
simulation mode. Parts of the mimic will animate to show the response of the outputs and
sensitive areas can be clicked on, to simulate the inputs. Use the ‘Open a mimic’ icon on the top
toolbar to select the mimic and the ‘Show mimic labels’ icon to display the labels [p.9].
Monitor bars show (monitor) the state of the inputs and outputs. These are normally displayed
at the bottom of the workspace [p.11].

Motors: These outputs control motors which can go forward and in reverse. Power control of
the motor is also possible [p.18].

Move individual symbols, labels or a group by selecting the Edit tool (hand). Click on the
symbol in the flowchart to be moved, it will highlight. Use the left mouse button to drag the
symbol and then release. To highlight a group of symbols, drag a box around the group. (Click
left mouse button at one corner of the group, drag a box across them and release). Select any
one of the highlighted symbols to drag the group [p.13].

New: Icon on the top toolbar will clear the workspace ready for a new flowchart.

Open: Icon on the top toolbar will open a .flo file folder.

Open Graph data (from Graph menu) will allow data, in the form of a flogdata file, to be
loaded back into the Flowol graph window [p.29].

Output symbol is used to turn an output [p.9] or motor [p.18] on or off, or call up a previously
recorded sound [p.16]. Note: if needed, all the outputs can be turned on or off in one symbol and
all the motors can be turned on or off in the one symbol.

Page Setup (File menu) can change the workspace dimensions, alter portrait to landscape and
allow you to select single sheet printing [p.25].

Paste allows copied sections of flowchart to be pasted back into Flowol or a word processor

[p.17].
Print Graph (from Graph menu) allows the whole graph to be printed [p.29].
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Print Icon allows the whole flowchart to be printed directly [p.11].

Print Preview (from File menu) allows the flowchart pages to be observed [p.25].

Process symbol is most frequently used for a delay [p.9] but is also needed to call up the
subroutines [p.15] or set up variables [p.21] e.g. ‘Delay 5’ or ‘Sub flash x 5* or ‘Lety=x+ 1’
respectively.

Prompt boxes: When a flowchart symbol is placed on the workspace an appropriate ‘prompt
box’ appears at the bottom of the screen. The instructions for that symbol are achieved by
clicking on the options made available in the prompt box [p.9].

Recursive: This is when a section of flowchart keeps repeating a process e.g. a flashing light

[p.10].
Redo allows you to step forward again in the flowchart construction if you have used Undo

[p.12].

Remote: If a remote interface is being used e.g. FlowGo, Solo etc then the ‘Remote’ button
transfers the program to that device.

Repeating Subroutines: When calling up a subroutine from the main program, the number of
repeats can be defined directly [p.15] or controlled with variables [p.30].

Run What? allows a subroutine or selected flowcharts to run on their own [p.15].

Save: Use the Save (disc) icon to save the flowchart with its current filename.

Save As... (in File menu) will allow the flowchart to be saved as a .flo file with a new filename
[p.9].

Save Graph data (in the Graph menu) allows the information to be saved as flogdata file [p.29].
Sensors: Digital inputs are either off or on, and can be produced by switches, pressure pads etc.
Analogue sensors produce a range of input values, e.g. light intensity, temperature, noise level
etc. If the program has been configured for an interface, the drop down menus on the val
monitor bar allows you to calibrate the sensors [p. 26].

Scale View: To change the size of the flowchart, change the ‘Zoom’ value on the top icon bar
[p.12].

Serial: The Serial port allows the computer to be connected to some interfaces [p.5].

Show graph: Use the icon on the top toolbar to open the graph window [p.26-28].

Simulate: [when the connection plug is open on the left hand toolbar] The mimics can then be
‘clicked on’ to simulate the effect of the inputs being changed. Click on the actual item (switch,
Sun etc) on the mimic, not on the label [p.14]. To simulate the change in analogue value from a
light or temperature sensor: click on the displayed number on the mimic with the left mouse
button to increase the reading in steps of 5, and right mouse button to decrease it [p.19]. The
analogue input can also be changed by dragging or clicking on the val reading in the val monitor
bar at the bottom of the workspace [p.24]. To operate an interface which is connected, click on
the connecting icon, to close it.

Sound: Pre-recorded sound files or those recorded on the Windows ‘Sound Recorder’ (opened
with the Sound Recorder icon on top toolbar) can be called up like an output in the flowchart
[p.16].

Speech can be called up like an output. Type the speech in the window [p.20].

Speed of Program: Reducing the speed of the flowchart is sometimes useful when
demonstrating or checking for errors. Select the ‘Speed’ from ‘Toolbars’ in the View menu and
adjust the slider [p.12].

Start symbol is needed at the beginning of a flowchart program. Many separate flowcharts can
be created (each with their own ‘Start” symbol). This number of Starts available may be less
when configured for some interfaces e.g. FlowGo & Solo [p.9].
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Stepping through the program: Select the ‘Speed’ bar, from ‘Toolbars’ in the View menu.
Pause the flowchart by clicking on the icon on the Speed toolbar, then step from one symbol to
the next using the Spacebar or step icon [p.12].

Stop symbol is needed at the end of a subroutine, and at the end of a program that is not
recursive (repeating) [p.9].

Stop all (in the Start/Stop prompt box) allows all the routines to be turned off from within the
control procedure [p.22].

Subroutine is a piece of program (a flowchart) which can be called up by a main routine. Note:
Subroutines must be defined before the main program [p.15].

Symbols represent the different types of commands which can be used to build up the flowchart
program [p.8]. To use a symbol, click on the symbol to select it; click again on the workspace to
position it [p.9].

Testing the mimic: Click on the input or output number or motor letter in the monitor bars
[p.18]. For motor, use left mouse button for forward and right button for reverse [p.18]. With
some mimics you can click on the actual item (not the label) on the mimic [p.12]. To test the
change in an analogue reading from a sensor: click on the displayed value on the mimic with the
left mouse button to increase in steps of 5, and right mouse button to decrease the value [p.19].
Testing the interface: Configure the program for an interface (‘Interface..” in the Settings menu)
[p.5]. Check that the connecting plug icon on the left hand toolbar is closed. Click on the outputs
on the monitor bars or mimic to change the state of the outputs. The output on the interface
should also change. Change the inputs on the interface and the input monitor bars should also
respond.

Text ‘T’ symbol allows headings or comments to be added to the flowchart [p.10].

Time interval and logging options of graph axes can be changed by selecting the ‘Logging
Options’ icon on the top toolbar. The time axis has a default setting of 2 minutes which keeps
doubling up indefinitely. This setting can be changed [p.27].

Toolbars on the left-hand side and top of the workspace allow you to select the symbols/tools or
icons to help you build and process the program [p.8].

Tooltips are provided next to the flowchart symbols, so you can read them more easily when
Zoom<80% [p.12].

Tutorial: As you progress through the tutorial, examples of control are introduced
progressively. The features of Flowol are introduced and explained at each stage to achieve the
control solutions [p.6].

Undo allows you to go back to an earlier stage of your flowchart construction [p.12]

USB: The USB (Universal Serial Bus) can be used to connect the computer to some types of
interfaces [p.5].

Vals are the values of the reading from analogue sensors [p.19 & p.24-27].

Variables are letters that can be assigned a value (Let n = 10). These variables can then be
mathematically manipulated. These are useful when counting, repeating subroutines and linking
separate flowcharts. The variable window can be opened by choosing the ‘Xy’ icon on the
toolbar [p.21-22 & p.30].

Workspace is the area on the screen where the flowchart can be built up [p.7].

Zoom: When the flowchart becomes too large to be seen in one frame, use the zoom (Scale
view) to observe more symbols on the monitor screen [p.12].
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Notes
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